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FILING TAX RETURN

(DECLARATION)

Here is how a taxpayer can file a tax return in IRIS 2.0.




RIS ALa FER
DASHBOARD SCREEN

After successful login, IRIS 2.0 Dashboard Screen shall appear, the taxpayer will click on “Declaration” from the
mega menu on the top of the screen.

The taxpayers can also use the quick link “File Your Income Tax Return”, available right below the mega menu.
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P OIRIS

SELECT DECLARATION TYPE

From the drop-down menu, the taxpayer will click on the second option of “Returns/Statements (Original)”,
and from the horizontally mapped menu, the option of “Normal Return (Ind/AOP/CQY)" will be clicked.

Registration ~ Assets Declaration =~ Rectification = Appeals ~ Refund ~ DNFBP -~ Withholding / Advance Tax ~ CPR Correction = Sales Tax = Invoice Management ~ MIS ~ Maloomat ~

All Options
> Salary Return for Individuals - Classic View > Normal Return (Ind/AQP/CQY) > Simplified Return for Manufacturers - Classic View

Returns & Statements > Simplified Return for Traders - Classic View > Statement of Final Taxation > Incomplete / transitional year
(Original-Simplified)
Returns / Statements > 116(2) (Wealth Statement) » MNon-resident Pakistan-origin person having no Pakis... > 116A(1) (Foreign Income & Assets Statement for Re...
[ﬂ"g'na” » Capital Value Tax 2022 - Statement of Foreign Assets » Non-resident ship owner / charterer > Non-resident aircraft owner / charterer
(Revised)
Simplified Return for SMEs having turnover up to 25... » 26(1) (Sales Tax and Federal Excise Return filed volu... > Null Sales Tax Return and Federal Excise Return
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P OIRIS

SELECT TAX PERIOD

Next, a pop screen will show up. The taxpayer will enter the relevant tax period in the Tax Period field
and click on the Continue button.
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P OIRIS

DATA TAB

The taxpayer will land on the Data tab and will click on the “Employment” tab, enter annual income in the
Pay, Wages, or Other Remuneration (including Arrears of Salary) tab.

Click on Calculate button in the top right corner of the form.

Registration * Declaration * Assets Declaration * Rectification ~ Appeals ~ Refund ~ DNFBP ~ Withholding / Advance Tax * CPR Correction * Sales Tax * Invoice Management * MIS ~ Maloomat ~

RIS Fear20l/ Save ® Submit & Print © Close O
™ 114(1) (Return of Income filed voluntarily for complete year)

oats N -
. Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute 1

> REPAR CALC
Employment Search Amount Code/Descrintlon Q IMPORT PREVIOUS RETURN P E PSID ULATE

Property >
Description Total Amount Amount Exempt from Tax ~ Amount Subject to Normal
Business » [ Subject to Fixed / Final Tax
Tax
Capital Assets >

Other Sources > l Income from Salary 1000




P OIRIS

TAX CHARGEABLE TAB

On the same page, the taxpayer will click on Tax Chargeable/ Payments, and from the drop-down menu,
select the “Computations” tab to view the Admitted Income Tax and will copy this amount.

Clicking on the “Prepare PSID" button will create the respective payment.

Employment Search Amount Code/Description

Property ’ Description

Business >

Capital Assets >

Other Sources > Turnover / Tax Chargeable u/s 113 @0.5%
Foreign Sources / Agriculture > Turnover / Tax Chargeable u/s 113 @1%

Super Tax Chargeable
Tax Chargeable / Payments >
Difference of Minimum Tax Chargeable u/s 148(8) / 153(3)(b)

= Deductible Allowances

- Tax Chargeable Difference of Minimum Tax Chargeable on Electricity Bill u/s 235

- Tax Reductions
Difference of Minimum Tax Chargeable u/s 113

- Tax Credits
] Adjustment of Minimum Tax Paid u/s 113 in earlier Year(s)
- Adjustable Tax
- Final / Fixed / Minimum / Average / Refund Adjustment of Other Year(s) against Demand of this Year

Relevant / Reduced Tax

Withholding | T
- Capital Assets u/s 7E ing income Tax

. Cﬂ'mputﬂ“ﬂnﬁ Advance Income Tax

Advance Income Tax u/s 147(A)

Admitted Income Tax

Q

923155

923160

923181

923192

923193

923194

923198

92101

9201

9202

92022

9203

Total Amount

IMPORT PREVIOUS RETURN

Amount Exempt from Tax
/ Subject to Fixed / Final
Tax

Amount Subject to Normal
Tax

F) Copy Amount
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P OIRIS

ADJUSTABLE TAX

On the same screen, click on the “Adjustable Tax” tab and paste the amount in “Salary of Employees u/s 149" Calculate Button
and click on Calculate button once again. AA

Import u/s 148 @1% 64010002

Import u/s 148 @2% 64010004

Import u/s 148 @3% 64010006

Import u/s 148 @4% 64010008

Import u/s 148 @4.5% 64010009

Import u/s 148 @5.5% 64010011

Import u/s 148 @6% 64010012 e e

Salary of Employees u/s 149 64020004 15,000 &/

Directorship Fee u/s 149(3) 64020005




P OIRIS

ADJUSTABLE TAX

The amount will be shifted fromm Admitted Income Tax to Withholding Income Tax.

Adjustment of Minimum Tax Paid u/s 113 in earlier Year(s) 023198
Refund Adjustment of Other Year(s) against Demand of this Year 92101
' | Withholding Income Tax 9201 15,000
~—
Advance Income Tax 9202
Amount Shifted
Advance Income Tax u/s 147(A) 92022
Admitted Income Tax 9203
Demanded Income Tax 9204




P OIRIS

WEALTH STATEMENT

To complete the process of income tax return, the taxpayer will have to enter the relevant information in all
three tabs of the Wealth Statement filed.

Emp!nyment ’ search Amount Code/Description q IMPORT PREVIOUS RETURM CALCULATE
Property ? i
Description Code Amount
Business »
Capital Assets 3 ‘ Personal Expenses 7089
Other Sources » Rent 7051
Foreign Sources / Agriculture » Rates / Taxes / Charge / Cess 7052
Tax Chargeable / Payments ¥ Vehicle Running / Maintenence 7055
Travelling 7056
116 - Wealth Statement
Electricity 7058
- Personal Expenses Water 7059
— Personal Assets / Liabilities Gas 7060
Telephone 7061

— Reconciliation of Net Assets

Asset Insurance [/ Security 066




P OIRIS

RECONCILIATION

Return process will complete only when the “Unreconciled Amount” is adjusted to “0”.

Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute
Employment 3 Search Amount Code/Description Q, IMPORT PREVIOUS RETURN I CALCULATE '
Property » Description Amount
Business >
Capital Assets y Gain on Disposal of Assets, excluding Capital Gain on Immovable Property 7038
Other Sources ; Income Attributable to Receipts (Builders/Developers) 7039
Foreign Sources / Agriculture » Others 7048
Tax Chargeable / Payments ¥ I Outflows 7099 42,000

Personal Expenses 7089 42,000
Wealth Statement >

Gift 7091

= Personal Expenses

Others
- Personal Assets / Liabilities 7098

' | of A
B T Nt Asset Loss on Disposal of Assets 7092

Unreconciled Amount 703000 0

Assets Transferred / Sold / Gifted / Donated during the year 703004




P OIRIS
SAVE DATA

Once the taxpayer has added and calculated all required fields, shall now click on the “Save” button to save
the entered data.

Registration ~ Declaration ~ Assets Declaration ~ Rectification ~ Appeals ~ Refund ~ DNFBP -~ Withholding / Advance Tax ~ CPR Cormrection ~ Sales Tax ~ Invoice Management ~ MIS ~ Maloomat ~

POIRIS Year2023 © 8 Print © 2]

™ 114(1) (Return of Income filed voluntarily for complete year)

m Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute m .

Employment ’ Search Amount Code/Description Q, IMPORT PREVIOUS RETURN PREPARE PSID D

Property >

Description Code Amount

Business >
Capital Assets > Net Assets Current Year 703001 20,000
Other Sources 3

Met Assets Previous Year E 703002 12,000
Foreign Sources / Agriculture > 0ooog

Increase / Decrease in Assets n D 8 000

703003 ;

Tax Chargeable / Payments > 00

Inflows 7049 50,000

Wealth Statement »




P OIRIS
UBMIT RETURN

Once data is saved, click on the “Submit” button. Enter the 4-digit pin in the opened dialogue box and click
on the “Submit” button.

ﬂ'R'E ki %) Save @ Submit & Print © Cancel €

™ 114(1) (Return of Income filed voluntarily for complete year)

Submit

Registration * Declaration ~ Assets Declaration ~ Rectification ~ Appeals ~ Refund = DNFBP ~ Withholding / Advance Tax * CPR Correction ~ Sales Tax * Invoice Management * MIS ~ Maloomat ~

HlRlE Year 2023 & Print @ Close &

™ 114(1) (Return of Income filed voluntarily for complete year)

M Individual 10 Ne[ed'(sW 1000000000010 , as Self / Member of Association of Persons / Representative (as defined in section 172 of the Income Tax Ordinance, 2001) of the

Taxpayer named above, do solemnly declare that to the best of my knowledge & belief the information given in this Return / Statement is correct & complete in accordance with the provisions of the

Income Tax Ordinance, 2007 & Income Tax Rules, 2002.

Enter 4 Digit Pin PIN ‘

Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute

4 Digit Pin




P OIRIS

OTHER TABS

Apart from the Data tab, the purpose of the other tabs is as follows;

Company Director




P OIRIS
AMORTIZATION TAB

It is a process of systematically allocating the price or value of an intangible (untouchable) asset or in the long run Liability
over a specific period. It involves spreading out the expense or value of an asset or liability over its useful life.

Registration = Declaration = Assets Declaration = Rectification = Appeals ~ Refund ~ DNFBP = Withholding / Advance Tax ~ CPR Correction = Sales Tax = Invoice Management = MIS = Maloomat -

pIIRIS  Tear202 “ Save @ Submit & Print  © Close O

™ 114(1) (Return of Income filed voluntarily for complete year)

Data Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute

Amortization

Search Amount Code/Description Q IMPORT PREVIOUS RETURN

Description WDV (BF) Remaining Useful Years Extent of Use Amortization

Intangible 1305
Expenditure providing Long Term Advantage / Benefit 330516
Pre-Commencement Expenditure 3306

Intangibles with Unascertainable useful life @4% 2307




P OIRIS
DEPRECIATION TAB

It is the systematic deduction (gradually decreasing value) of the cost or value of an asset over the passage of time.

Registration = Declaration = Assets Declaration = Rectification = Appeals =~ Refund = DNFBP = Withholding / Advance Tax = CPR Correction = Sales Tax = Invoice Management = MIS = Maloomat -

HlR]E bk ) Save @ Submit & Print  © Close &
™ 174(1) (Return of Income filed voluntarily for complete year)

Data Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute
Depreciation
Search Amount Code/Description Q

IMPORT PREVIOUS RETURN

Description WDV (BF)/ Addition (Used in Extent of Use Addition (New on Extent of Use Initial Allowance Depreciation
(Additions Prior Pakistan) or after 1st July
to 1st July 2020) 2020)
Building (all types) 3302
Ramp for Disabled Persons 330204
Plant / Machinery (not Otherwise 330307
Specified)

Computer Hardware / Allied Items / 230307




P OIRIS
MINIMUM TAX TAB

This refers to a tax provision that sets a minimum amount of tax liability that must be paid by individuals or companies,
regardless of their regular tax calculations.

Registration = Declaration = Assets Declaration = Rectification = Appeals = Refund = DNFBP ~

Withholding / Advance Tax = CPR Correction = Sales Tax ~ Invoice Management = MIS = Maloomat -

NIR':_—_ Year 2021

“) Save @ Submit & Print @ Close &
™ 114(1) (Return of Income filed voluntarily for complete year)
Data Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute
Minimum Tax
Search Amount CU'L'IE!."DESE’.TH:'[I'DI'I q IMPORT PREVIOUS RETURN

Description

Receipts / Value Tax Collected / Deducted Tax Chargeable Attributable Taxable

Tax on Attributable Difference of Minimum
Income Taxable Income Tax Chargeable

/ Paid

Import u/s 148 @1% 64010052

Import u/s 148 @2% 64010054

Import u/s 148 @3% 640710056

Import u/s 148 (@41 40710088




P OIRIS
OPTION OUT OF PTR TAB

Presumptive Tax Regime (PTR) implies on specialized activities of a person.

Registration ~ Declaration ~ Assets Declaration ~ Rectification ~ Appeals ~ Refund ~ DNFBP ~ Withholding / Advance Tax ~ CPR Correction ~ Sales Tax = Invoice Management ~ MIS ~ Maloomat ~

HlRlE Year 2021 = Save @ Submit & Print & Close 8

™ 114(1) (Return of Income filed voluntarily for complete year)

Data Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute

Option out of PTR

[Bsna )
Search Amount Code/Description CL IMPORT PREVIOUS RETURN - CALCULATE

Description Receipts / Value Tax Collected / Deducted Tax Chargeable Attributable Taxable Tax on Attributable Difference (Option Valid

/ Paid Income Taxable Income if <=0)

Export Proceeds u/s 154(1) @1% 64070054
Foreign Indenting Commission u/s 154(2) 64070151
Sale Proceeds of Goods to Exporter u/s 154(3) 64070152
Sale Proceeds of Goods by Industrial undertaking u/s 154(3A) 64070153

NOTE: In IRIS 2.0, upon shifting between Data, Amortization, Depreciation, Minimum Tax, and Option

out of PTR tab, the initial entered value/ amount will be auto-calculated accordingly.




P OIRIS

PAYMENT TAB

This tab allows the taxpayer to add/Claim payments.

Data Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute
Payments
£3 PKR (4 PKR — PKR
Unclaimed Payments Claimed Payments Payment Summary
Not Available! Not Available! Not Available!

RELOAD &




P OIRIS

PAYMENT TAB

The Claimed Payments can also be deleted. After the deletion, the payment can be viewed in the
Unclaimed Payments section

Data Amortization Depreciation Minimum Tax Option out of PTR Company Director Attachment Attribute
Payments
Unclaimed Payments (2) RELOAD C Claimed Payments (1) Head wise Summary
IT2021091701011367709 IT2021033000000864220 IT2021122701111474365
Amount Head: 9203
Code: 9203 Code: 9202 Code: 9203
Amount: 2887404 Amount: 450000 Amount: 179715 Amount: 179715

o o B
o~

DELETE Payment




P OIRIS

COMPANY DIRECTOR TAB

This tab allows the taxpayer to add a company director so that taxes can be managed accurately.

Data Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute

Company Directors

Add Directors

Registration No* Proprietor/Member/Partner * Capital Amount* &4 Add Director




P OIRIS

ATTACHMENT TAB

The taxpayer can attach relevant documents on this tab if required.

Registration * Declaration * Assets Declaration * Rectification ~ Appeals * Refund ~ DNFBP ~ Withholding / Advance Tax ~ CPR Correction * Sales Tax * Invoice Management *~ MIS ~ Maloomat ~

""RlE YeRs cast ) Save @ Submit & Print © Close &

™ 114(1) (Return of Income filed voluntarily for complete year)

Data Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attribute

Attachments

Manufacturing and Trading / Profit and Final Accounts (3000)
Loss Accounts statements (9230)




P OIRIS

ATTRIBUTE TAB

The taxpayer can attach relevant attributes on this tab if required.

Registration ~ Declaration ~ Assets Declaration ~ Rectification ~ Appeals ~ Refund ~ DNFBP = Withholding / Advance Tax = CPR Correction ~ Sales Tax ~ Invoice Management ~ MIS ~ Maloomat ~

ﬂIRIE Year 2021 °) Save @ Submit & Print  © Close 6
™ 114(1) (Return of Income filed voluntarily for complete year)

Data Amortization Depreciation Minimum Tax Option out of PTR Payment Company Director Attachment Attribute
Attributes
Business Sector-1 Business Sector-2
Trader - Members/ Brokers/ Agents of Stock Exchange/ Mercantile exchange - Select option -

Business Sector-3 Business Sector-4




HELPLINE

National: 051 111 772 772
International: +92 51 111 772 772

Email: helpline@fbr.gov.pk
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